Developing a Regulation Policy for Lake Superior: Optimization and Trade-Off Analysis

Sara M. O’Connell¹, David W. Watkins, Jr.², and Matthew M. McPherson³

Background

Lake Superior is the largest lake in the world by surface area⁴, and it is also the largest regulated freshwater body. It drains an area of more than 200,000 km², including the lake surface itself. The lake’s outlet is the St. Marys River, which flows into Lake Huron. Water discharging from Lake Superior passes through the Soo Locks, a set of gate structures called the Compensating Works, and hydroelectric power facilities on the U.S. or Canadian sides of the channel. Despite these outlet facilities, Lake Superior can be regulated only to a certain extent, with levels and flows largely dictated by natural hydrologic processes.

The regulation of Lake Superior is generally considered to have begun in 1888, when a railroad trestle was built across the St. Marys River, near the head of the St. Marys Rapids, restricting the river’s discharge capacity (Coordinating Committee, 1994). Then, in the 1890s, the U.S. and Canada constructed diversion canals for hydroelectric plants, which increased the total flow capacity of the river. In 1901, construction of “compensating works” began at the head of the rapids on the Canadian side. These consisted of four sluice gates, each 16 meters wide between large masonry piers. By 1914, navigation and power canals were added, further reducing the cross-section of the river. Additional gates were added to the compensating works on both the U.S. and Canadian sides until 1921, when modern-day control of the outlet of Lake Superior was achieved with a 16-gate structure approximately 300 meters in length (Clites and Quinn, 2003).

The legal doctrines directing the management of the Great Lakes by the U.S. and Canada are based on the Boundary Waters Treaty of 1909, which established the International Joint Commission (IJC), and the Orders of Approval of 1914. At that time, the specified purposes of regulation were commercial navigation, hydroelectric power generation, domestic and sanitary uses, and irrigation; there was no mention of environmental, recreational, or shoreline property impacts (flooding or low levels). Since 1921, several Lake Superior regulation plans have been in place, with plans typically being modified, or new plans adopted, following periods of extremely high or low levels (e.g., low levels in the 1920s and 1960s, and high levels in the 1980s).

¹ Hydraulic Research Engineer, Hydrologic Engineering Center, Institute for Water Resources, U.S. Army Corps of Engineers, 609 2nd St., Davis, CA, 95616. E-mail: sara.m.oconnell@usace.army.mil
² Professor, Dept. of Civil and Environmental Engineering, Michigan Technological University, Houghton, MI 49931.
⁴ If Lake Michigan and Lake Huron are counted as two lakes.
The current regulation plan, described below, continues regulation practices instituted in 1974 (Clites and Quinn, 2003).

In 2007, the International Joint Commission appointed the International Upper Great Lakes Study Board to examine whether the regulation of Lake Superior outflows could be improved to address potential climate change impacts and the evolving needs of the upper Great Lakes. The study area includes lakes Superior, Michigan, Huron and Erie, and their interconnecting channels (St. Marys River, St. Clair River, Lake St. Clair, Detroit River and Niagara River), downstream to Niagara Falls. See Figure 1. Major topics for investigation include determining the factors that affect water levels and flows, including potential impacts of climate change; developing and testing alternative new regulation plans; and assessing the impacts of these alternative plans on the ecosystem and human interests.

![Diagram of the Great Lakes, connecting channels, and diversions.]

**Figure 1. The Great Lakes, connecting channels, and diversions.**

**Current Regulation Plan**

The current regulation plan, known as Plan 1977-A, specifies monthly mean Lake Superior outflows with the objective of balancing the levels of Lakes Superior and Michigan-Huron relative to their historical ranges. The monthly flow is allocated first to meet the needs of municipal and industrial water users, operate the navigation...
locks, and provide sufficient flow to maintain the aquatic habitat of the St. Marys Rapids. In accordance with IJC requirements, a one-half gate open setting (about 60-95 m$^3$/s, depending on Lake Superior levels) is the minimum allowable to provide flows for the main portion of the rapids. Additionally, a continuous supply of water (15 m$^3$/s) is provided for the fishery remedial works. The remainder of the Lake Superior outflow is allocated equally between the U.S. and Canada to generate electricity. If the amount of water available for hydropower generation exceeds the capacities of the hydropower plants (about 2,300 m$^3$/s), the excess is released by opening more gates at the compensating works.

If Lake Superior is experiencing low levels (defined as below 183.4 m), the IJC mandates that releases cannot exceed “preproject” releases, defined by a formula that represents natural (unregulated) flows in the St. Marys River. This requirement is meant to ensure that Lake Superior levels are maintained above seasonal and historical low levels as much as practicable. In addition, a maximum release is specified in the winter to prevent ice jams in the St. Marys River.

The IJC may, and frequently does, approve deviations from the regulation plan. For instance, in the spring of 1985, the water levels of Lakes Michigan-Huron were almost 60 cm above average, while Lake Superior was less than 15 cm above average. The continued high water supply conditions on Lakes Michigan-Huron and Erie made it impossible for Plan 1977-A to keep the lakes balanced with regard to their respective mean levels. To provide relief to the shore property interests on the downstream lakes, the IJC approved Lake Superior outflows less than specified by the regulation plan beginning in May 1985. By the end of September, the net impact of the deviation was an 11-cm rise in water levels on Lake Superior and a 7-cm drop on Lakes Michigan-Huron (Yee et al., 1993).

**Assignment**

Use a network flow optimization model, HEC-ResPRM (USACE, 2011), to evaluate some of the trade-offs faced in developing a new regulation policy for Lake Superior. Given a set of objective functions that represent different operating purposes and interests (hydropower, navigation, recreational boating, shoreline property), evaluate trade-offs by adjusting weights on the various functions. Then propose a “balanced” plan (set of weights) that does not cause inordinate damage to any particular interest on Lake Superior. Include the following in your analysis:

- Summarize the trade-offs between the different operating objectives in a single table, or trade-off matrix. Include your final proposed plan (generated with a set of “compromise” weights) for comparison.

- Compare historical levels under Plan 1977-A with those that would have resulted from your proposed plan.

- Perform a sensitivity analysis (± 20% changes in Net Basin Supplies) to quantify potential impacts of climate change and the robustness of your proposed plan.
- **Optional**: Since ecosystem functions (wetlands, fisheries) have not been included in the optimization model, evaluate (qualitatively or quantitatively) the performance of your proposed plan with respect to this objective in a *post-optimization* analysis. See details below on estimating ecosystem function (wetlands) benefits.

- **Optional**: Because of complications associated with modeling unregulated outflows from Lake Huron (discharges in the St. Clair River), Lakes Michigan-Huron levels will not be included in the optimization model, but they may be simulated post-optimization. Using the spreadsheet provided, compare historical Michigan-Huron levels under Plan 1977-A with those that would have resulted from your proposed plan. Comment on the importance and practicality of “balancing” the lakes.

**Data and Assumptions**

To complete this assignment you will need both historical hydrologic data, to model the physical system, as well as socioeconomic and environmental data, to quantify benefits (impacts) in the optimization model objective function or constraints.

Historical hydrologic data, readily available on-line from the NOAA Great Lakes Environmental Research Lab (http://www.glerl.noaa.gov/data/arc/hydro/mnth-hydro.html), has been compiled in HEC-DSS format. Using this data, water levels may be computed simply as:

\[ \Delta W = Q_i + NBS - Q_o \]

where \( \Delta W \) is the change in water level, \( Q_i \) is inflow to the lake from upstream lakes or diversions, \( NBS = \text{net basin supplies (equal to precipitation + runoff – evaporation)} \), and \( Q_o \) is outflow from the lake (all in equivalent depth units). For Lake Superior, \( NBS \) values are generally negative in the early winter, when snowpack accumulates and evaporation is high; close to zero in the late winter, when the lake surface freezes; positive in the spring and summer due to snowmelt, high runoff, and reduced evaporation; and then decreasing in the fall when evaporation rates increase. A relatively small but continuous inflow also occurs throughout the year from diversions from the Hudson Bay watershed (Long Lake and Ogoki projects).

Limited socioeconomic and environmental data were available at this time of this writing, as the development and compilation of data for the IJC study was under way. Below is some guidance on quantifying impacts, which was followed to develop HEC-ResPRM objective functions for this case study. For updates, the reader is referred to the IUGLS web site: http://iugls.org.

Recreational Boating and Tourism - Low water levels are a concern for recreational boating and tourism because they make some docks and boat ramps unusable, shorten the boating season, increase boat-propeller damage, and reduce accessibility. During low-water conditions in Summer 2007, when mean lake levels were as low as 182.9
m, about 60% of available dock space at Isle Royale National Park was inaccessible, and the ferry was not able to run to the park from Grand Portage, MN. High water levels can overtop boat docks and flood marinas, as occurred during the record high water levels of the 1980s.

The economic impact of recreational boating on all the Great Lakes has been estimated to be $6.3 billion annually (Allardice and Thorp, 1995). In lieu of an economic impact study for Lake Superior, a simple “interest satisfaction curve” (Eberhardt, 1994) may be used, based on the fraction of boat launches accessible at different lake levels. This curve, based on data collected by Bill Werick (personal communication, January 2011), is shown in Figure 2. In HEC-ResPRM, this curve forms the basis of a penalty function to be minimized. The penalty function is essentially the inverse interest satisfaction curve (i.e., a penalty of zero for lake levels between 183.18 and 183.64 m).

Figure 2. Fraction of boat launches usable at different water levels (B. Werick, personal communication, Jan, 2011).

Hydroelectric Power - High Lake Superior levels and outflows increase hydropower generation, while low levels and flows reduce generation. At Sault Ste. Marie, flows for hydropower generation are divided between Canada and the U.S. On the U.S. side, the Edison Sault Electric plant can handle nearly 900 m$^3$/s and generates between 25-30 MW when fully on-line, or about 225 million KWh annually. Additionally, the Corps of Engineers hydropower plant at the Soo Locks generates 150 million KWh.

Societal benefits from hydropower generation are typically assumed to be the cost savings from power generation by coal- or gas-fired plants. Without conducting a study to estimate these savings, the objective of maximizing hydropower revenues
may be used instead. Based on simulated hydroelectric energy generation for the period 1900-2008 under Plan 1977-A (B. Werick, personal communication, January 2011), hydroelectric power generation may be approximated as a linear function of St. Marys flow up to a maximum of about 95 MW at a total flow of 2,400 m³/s, as shown in Figure 3. This power generation function is combined with monthly varying prices, ranging from about $44/MWh in May to $62/MWh in January, to develop economic-based penalty functions for HEC-ResPRM.

![Figure 3. Monthly hydroelectric power generation as a function of St. Marys flow (m³/s), for a range of Lake Superior water levels (data from B. Werick, personal communication, Jan. 2011).](image)

**Commercial Navigation** - Low water levels reduce a ship’s capacity to transport cargo and thus require more trips, increasing operating costs. For some harbors such as that at Thunder Bay, low water levels can seriously disrupt shipping, particularly when they fall below chart datum (601.1 ft, or 183.2 m).

To estimate commercial navigation impacts, consider that the Soo Locks had 75 million tons of commodities in 2003, including iron ore (54% of total at value of $30/ton), coal (25% at $40/ton), and grain (12% at $170/ton) (http://outreach.lrh.usace.army.mil/States/Mi/Default.htm). In this analysis we will assume that lake levels remain high enough for these goods to be shipped (i.e., no modal shifts occur), but a $0.60/ton increase in shipping costs is incurred for every 1 ft (.3048 m) the water level drops below 601.5 ft (183.34 m) (David et al., 1998). To develop monthly penalty functions in HEC-ResPRM, average monthly tonnage data are used to distribute the annual impacts over the shipping season, March through December.

**Shoreline Property (Coastal)** - Low water levels may reduce property values for aesthetic purposes, and reduce shoreline recreational opportunities, while high levels increase the likelihood of storm damage. In lieu of economic data to formulate these
penalty functions, it is assumed that shoreline interests are adversely affected whenever lake levels are more than two standard deviations above or below their monthly mean values (expected to occur only 5% of the time), shown in Figure 4.

Figure 4. Minimum and maximum lake levels beyond which adverse coastal impacts are assumed to occur.

Ecosystem (Wetlands) - Seasonal and long-term cycles of high and low water levels are considered by experts in the biology community to be essential for the well-being of Great Lakes wetlands. Persistent high or low levels can have adverse impacts on wetlands diversity. Also, when water levels move to and remain at a different regime, wetlands have difficulty migrating to the new regime and may take years to recover.

Although a comprehensive study of Lake Superior wetlands has not been completed at the time of this writing, you may assume a goal similar to one proposed for Lake Ontario regulation—maximize the area (zone) suitable for the meadow marsh community, characterized by a high degree of plant diversity and dominated by short emergent vegetation (grasses, forbs, sedges, etc.), but also including some shrub and tree overstory. This zone may be defined by elevations last flooded 5 to 30 years ago. Five different wetland communities may be identified (Wilcox et al., 2005):

- Upland transition community – last flooded > 30 years ago.
- Meadow marsh community – last flooded 5-30 years ago.
- Emergent marsh community #1, dominated by thin-stem persistent emergent vegetation (mainly cattail) and does not support the same level of diversity supported by the meadow marsh community – last flooded < 5 years and/or last dewatered during growing season < 4 years ago.
• Emergent marsh community #2 – last dewatered during growing season 4-39 years ago.
• Submerged/ floating leaf community, dominated by submerged vegetation, floating leaf vegetation, and algae – last dewatered during growing season > 39 years ago.

Instructions for HEC-ResPRM

This section provides a brief summary of the basic steps required to run HEC-ResPRM and complete the assignment. For an introduction to other software capabilities, the reader is referred to the *HEC-ResPRM Quick Start Guide* (USACE, 2011).

**Step 1. Installation and Data Set Up:** Install HEC-ResPRM and copy the case study watershed files (contained in the directory “Lake_Superior”) to the local C: drive. Place the folder called “Lake_Superior” inside another folder called “Base.” For example, the path to your case study files may be “C:/PRM/Base/Lake_Superior/.”

**Step 2. Watershed Location:** Define the watershed location by selecting **Options** from the **Tools** menu. The Options Editor is shown in Figure 5.

![Options Editor](image)

**Figure 5.** From the Tools menu, select the Options Editor and then the Model Directories tab in order to create a Model Directory.

The first tab of the Options editor, **Model Directories**, is used to define Watershed Locations. To add a new location to the list, press the **Add Location**… button. The Add Watershed Location screen will appear. Browse to the directory above the “Base” directory where the Lake_Superior watershed is located and press **OK**. For the example shown in Step 1, the Watershed Location would be “C:/PRM/.”

**Step 3. Modular organization of the HEC-ResPRM program:** There are three modules within the HEC-ResPRM program: **Watershed Setup, Network**, and **Optimization**. Although this assignment will only require interaction with the
Network and Optimization Modules of HEC-ResPRM, the reader is encouraged to browse through all three modules that constitute the Lake Superior case study watershed. Each module provides access to specific types and directories of data within the watershed data tree. The Watershed Setup Module is where the Stream Alignment is drawn and the basic shape and connectivity of a basin is defined. The configuration of projects – reservoirs and diversions – is also done in this module. Adding physical data and penalty functions is done in the Network Module. Compute options are set by creating Alternatives, each of which is based on a Network. The Optimization Module is used for running optimizations on selected Alternatives. An Optimization in HEC-ResPRM terms is a time period, over which one or more Alternatives will be optimized. Each Alternative added to an Optimization is a copy of an Alternative from the Network. Some attention is required to maintain consistency between the Network version and the Optimization version of each Alternative. Figure 6 provides a graphical illustration of the modules. Refer back to this figure to help keep the concepts organized as you learn more about the function of each module.

![Figure 6. HEC-ResPRM Modules](image)

Step 4. Model constraints and penalty functions: Model constraints and penalty functions are initially input in the Network Module, but they can be viewed (and some changes can be made) in the Optimization Module. Start in the Network Module by opening the Base network (if not already opened), and then open the Reservoir Editor and right-click on the reservoir (Lake Superior) with the arrow tool or the reservoir tool. Select Edit Reservoir Properties from the dropdown menu. (You can also access this Editor by selecting Reservoirs... from the Edit toolbar.) Select the Constraints tab (Figure 7) to view model constraints, which can be either constants, monthly constants, or a time-series. Note that there are two different types of constraints (storage and release), and they can be viewed by using the drop-down Constraint Type selector. In this case, storage constraints are...
constant, but release constraints are defined as monthly constants, representing summer and winter seasons.

In this model, the release constraints are in units of million m$^3$/month (MCM). The storage constraints are defined in terms of million m$^3$, based on an arbitrary datum of 0 meters above mean sea level. They correspond to lake elevations of 182.8 and 184.1 meters above mean sea level, respectively.

Penalty Function data are found on the Storage, Release, and Power Release tabs. Individual Penalty Functions are defined by season and then grouped into PenaltySets and Composite Penalties. Each PenaltySet is intended to represent one particular interest (e.g., commercial navigation, recreational boating, hydropower) and consists of up to 12 individual Penalty Functions – one for each month. The Penalty Functions vary based on the season selected for each month. If a penalty applies consistently all year, a single “all year” season can be applied to every month. (This is the default setting.)

A single reservoir or river reach may have several competing purposes, with each interest associated with a different PenaltySet. When optimizing the system, HEC-ResPRM combines these separate penalties into a monthly varying Composite penalty function. Composites must be specified for each reservoir storage and reservoir release link in an HEC-ResPRM model. Figure 9 shows the layout of the Storage tab of the reservoir editor with an active Composite. In the bottom left panel, Monthly Penalties, you can select each month to view the total (composite) storage penalty that will be applied for that month. The PenaltySet Weight Editor at the bottom middle allows you to apply weights to the various PenaltySets that contribute to your composite.

The Power Release tab is set up slightly differently than the Storage and Release tabs. Only one hydropower penalty set can be used for any given run, so there is no composite penalty. Because hydropower generation is dependent on both head and release, it is more difficult to accurately reflect hydropower penalties. This relationship is roughly approximated in HEC-ResPRM with the ability to make power penalty sets vary with respect to storage and flow. For simplicity, and because storage (head) does not change dramatically compared to the release, the Lake Superior power penalty does not vary with storage. More can be learned about HEC-ResPRM power calculations by reading the HEC-ResPRM Quick Start Guide or the HEC-ResPRM User’s Manual (USACE, 2011).
Figure 7. Storage Capacity constraints for Lake Superior

Figure 8. Storage tab of the Reservoir Editor with the “Recreation” Composite Penalty active.
Step 5. **Setting up Alternatives:** One or more Alternatives must be defined prior to running an *Optimization*. From the Alternative menu (in the Network Module) select Edit. The Alternative Editor window will appear, showing a list of existing Alternatives. A user can create a new Alternative by selecting New... from the Alternative Menu, and then selecting the parameters that should be applied.

An Alternative called “Baseline” has already been created for this model. Click on “Baseline” in the upper panel of the Alternative Editor and then look at the tabs in the bottom panel to view the input data and options selected for the Alternative.

The **Penalty Assignments** tab shows which Composite Penalties will be applied for Lake Superior Storage and Release, and which PenaltySet will be applied for hydropower (Figure 9). (Note that a Composite Penalty is mandatory for Reservoir Storage and Release, so even though no Release penalties are used, a “Zero” penalty Composite has been applied.) On the **Reservoir** tab, the Initial and Ending Storage values are set (Figure 10). The **Time-Series** tab shows the input data set (Figure 11). The **Compute Options** tab shows special compute settings (Figure 12). For this model, default compute options were not changed, except the **Restricted Basis Entry** is turned on. This option turns on an algorithm that allows for the use of non-convex penalty functions.

![Figure 9. Alternative Editor with Penalty Assignments tab active (showing assigned penalties).](image-url)
Figure 10. Alternative Editor with Reservoir tab active (showing starting and ending storage volumes).

Figure 11. Alternative Editor with Time-Series tab active (showing Net Basin Supply time-series).

Figure 12. Alternative Editor with Compute Options tab active (showing default settings, except Restricted Basis Entry is ON under Solution Algorithm Options).
Step 6. Computing Alternatives: Once at least one Alternative has been defined, an Optimization can be built and the Alternative can be run. Select Optimization from the Module dropdown selector. An Optimization in HEC-ResPRM is defined as the time window over which one or more Alternatives will be computed. An Optimization covering the Period of Record (1900-2008) has been created. Open the “1900-2008” Optimization, using the Optimization menu. Next, click on the “Compute \{Name of Alternative\}” button in the control panel of the Optimization Module’s main window to perform the computations. A compute window will appear showing status messages and program progress. When the computation is finished, a “Compute Complete” message will appear and the status bar will read 100%. Click Close to close this window.

To view the console output, you may select PRM Console Output and the Alternative name under the Reports menu. This shows that the model includes over 15,000 network links and solves in about 10,000 iterations, which should take no more than a couple seconds on modern PCs.

Step 7. Reviewing Model Results: Model results can be accessed and visualized in three different ways: Plots, DSS Viewer, or Summary Reports, but for brevity, only Plots and DSS Viewer will be described here. On the model schematic you can right-click on a model element to get a menu list. Choose the Plot option to display the default time-series graph. The plotted results can be tabulated by selecting Tabulate from the plot’s File menu. Alternatively, when Hec-DssVue is selected from the Tools menu, a DSS file is opened that contains the results of the Optimization. A list of pathnames is provided, and a screened list can be obtained by selecting a pathname part from the lists in the Search by Parts section of the window. To select records to be displayed, highlight the pathnames and click on the Select button. After one or more records are selected, the buttons for plot and tabulate become active. Click either button to generate the associated output.

To view other time series plots, start by right-clicking on the Lake Superior reservoir and select Plot Elevation. This will provide a plot of lake levels (in meters) along with a second plot of inflows and releases (in million m³/month). To display different variables, choose Select Variables under the Plot menu, and add or remove variables as desired. Note that the y-axis scale may need to be adjusted, and this may be done by selecting Plot Properties under the Edit menu. By right-clicking on the reservoir icon, you may also display time-series of storage and power release penalties.

Step 8. Use weights to adjust the impact of each Penalty Set: In the optimization Module, Select the Penalty Manager from the Edit menu. Here you can define PenaltySet Groups, based on the types of objectives you are operating for. For this study, four “Groups” have already been created, each containing the appropriate PenaltySets. (In this case, there is only one PenaltySet for each group.) The groups are Recreation, Hydropower, Navigation, and Coastal. You can change the impact of each objective by adjusting its Group’s weight. In order to change the weights, select a Group from the dropdown list on the Grouped tab, change the Weight value, click Set, then click Apply. (See Figure 13 for an example of changing the weight on the
Coastal group.) You can view the current weights for all your Penalty Sets on the Sorted tab. (There are other ways to apply weights to penalties in HEC-ResPRM, but this allows the weights to all be applied in a single location.)

Use the Penalty Manager to adjust the Group weights, then recompute your Alternative. Check the results of your run by plotting output and by looking at the Penalty Report. The Penalty Report can be found under the Reports menu. On its Groups tab, it will report the total penalty accumulated over the time window for each group. Since the Hydropower and Navigation penalty sets were input in terms of $1 million, these are the units of the total penalty for those groups. The Recreation and Coastal penalties were input as relative penalties, ranging from zero to approximately 1.0.

A good way to begin the process of trade-off analysis is to develop a so-called “pay-off table,” which shows the best possible solution (lowest possible penalty) for each objective (or penalty group). This is generated by solving the model once for each group, with that group’s weight set to 1.0 and all others set to zero. Use the data from the Penalty Report to record each penalty group’s total penalty for each run. Once the pay-off table is generated, repeat the process of adjusting weights, recomputing, and examining results until you have achieved a reasonable balance between the different Lake Superior objectives. Keep in mind that weights may need to be adjusted by significant factors (0.01, 0.1, 10, or 100) to see appreciable changes in the results.

Figure 13. Adjust weights on groups of Penalty Sets using the PenaltySet Manager.
Step 9. Adjust time series inputs to model climate change using Hec-DssVue:
Climate change may impact the operation of Lake Superior. Rerun the Alternative using inflows adjusted for climate change to see how well the different objectives stay in balance. Begin by right-clicking on the Baseline Alternative in the Optimization Control Panel. Select **Save to Base…** in order to save any changes that were made to the Alternative in the Optimization Module to the copy of the Alternative in the Network Module. (The only changes were the weights on the Penalty Groups.) Next, go to the Network Module, and open the Alternative Editor. Create a copy of the current Alternative using the **Save As…** feature of the Alternative Menu. Name the Alternative “Climate”. Figure 14 shows the screen shots for saving a copy of an Alternative.

Next go to the **Time-Series** tab of the Alternative Editor. Highlight the “Superior_IN” time-series and click on **Select DSS Path…** in order to map a different inflow time-series (Figure 15). The DSS Selector will automatically open the DSS file that holds the original inflow time-series. To replace it with the climate change time-series, highlight the “IUGLS-CLIMATE CHANGE FLOW-IN-NET” time-series, click **Set Pathname**, and close the DSS Selector (Figure 16). Save the Alternative and close the Alternative Editor.

![Figure 14. Create a copy of an existing Alternative using the Save As… option.](image)
Figure 15. Input time-series can be changed using the Select DSS Path… button on the Time-Series tab of the Alternative Editor.

Figure 16. The DSS Selector is used to map input data.
Save the Network, and switch to the Optimization Module. From the Optimization menu, choose **Edit...** Check the box next to the Climate Alternative in order to add it to the Optimization. Check the **Run New Extract** box to get the Optimization to retrieve the new DSS data. Then click OK. These steps are shown in Figure 17. The Climate Alternative will appear below Baseline in the Optimization Control panel.

In the Optimization Control panel, right-click the Climate Alternative and **Set As Active**, as shown in Figure 18. Now Compute the Climate Change Alternative.

Compare results between the Baseline and Climate Change Alternative. Has there been a significant change in the balance between different objectives?

---

**Figure 17.** Edit the Optimization to add new Alternatives and select Run New Extract to import the new input time-series.
Figure 18. Change the active Alternative using the Optimization Control panel.

References


